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Copyright Notice

The Learning Labs, Inc. (“TLL”)
All rights reserved, 2007
Reproduction in any form without permission is prohibited.

Disclaimer

Information in this document is subject to change without notice and does not
represent a commitment on the part of TLL.

TLL provides this document as is, without warranty of any kind, expressed or
implied, including but not limited to the warranty of merchantability or fitness for a
particular purpose. TLL may make improvements and/or changes in this manual or
in the products(s) and/or the program(s) described in this manual at any time.

Information in this manual is intended to be accurate and reliable. However, TLL
assumes no responsibility for its use, or for any infringements of rights of other
parties, which may result from its use.

This document could include technical or typographical errors. Changes are
periodically made to the information herein; these changes may be incorporated in
new editions of the publication. This manual is provided solely and exclusively for
educational use and this information or related products should not be used nor
relied upon for any purpose except for education and training.

Technical Support

Please contact your local TLL authorized product representative for questions
regarding hardware, software, or applications issues. Any updates or patches will
be sent to you as long as your registration is current. The TLL products are
designed to be supported remotely by allowing viewing of the user desktop. It is
highly recommended that the PC from which you are using TLL products is
connected to an Internet link that allows Web browser access. In this way our
technical support staff can view your desktop and work with you to understand
and solve technical issues.
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Chapter 1

Prerequisites

System Requirements

The following are the prerequisites for a computer to run the required software tools for doing basic
digital designs on theTLL5000. Make sure that these components and minimum hardware are
present.

Personal Computer: Pentium 1 GHz or higher -- Although lower processors will run the software
tools, the desired results are not guaranteed.

512MB RAM — for average applications, larger designs a 1GB RAM or greater is useful.

Minimum 5-GB on Hard Disk — The Webpack ISE requires around 3.5 GB for all its components.

SVGA Monitor with the resolution of 1024x768 -- Monitor resolutions has been kept at
1024x768, which is ideal.

Windows 2000 or XP operating system with ServicePack-4 (for Windows 2000) & ServicePack-2
(for WinXP)

Three USB2.0 ports

One RS232 serial port

Ethernet Network Interface Card (NIC) The network interface card should have been configured
on your system. Make sure that you have configured the network card with a static IP address.

Software requirements

The following software needs to be installed in the PC used for connecting to the TLL5000 Base
Module.

Xilinx Webpack ISE 9.x (our limited experience is that the Xilinx ISE version 8.x should also
work, but we recommend that you use version 9.x). If you are using the previous versions of
ISE, please update with the service packs for getting the drivers for the Xilinx Programming
Cable. This tool is provided with, ISE simulator, XST synthesizer, PAR and downloads (iMPACT)
applications.

ModelSim-XE — the Simulation software for behavioral simulation. One should also be able to do
these exercises using the full ModelSim software from Mentor Graphics but there will be
differences in methods and commands that this manual does not address.

Hardware requirements

e The following items are required to start using the system.

e TLL5000 Base Module.

e Power supply for TLL5000 (18volts / 3.5 Amps)

e USB cables — 2 Nos.

o Xilinx Platform Programming Cable — newer versions use an USB interface, but parallel cables
will also work.

e CDs with, User Documentations and Software.
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The CDs provided with the TLL5000 will typically contain the following items. Please consult with
your local TLL product partner for specific details as your configuration may be different from this

table.

CD Directory Description Remarks
Various application utilities and Please check with your local
TLL User Software . PP TLL partner to verify that the
1 associated software and hardware
and Manuals manuals and software are the
manuals for the TLL5000. .
most current versions.
As a convenience for the user, this These tools will have a license
CD has the freely downloadable duration determined by Xilinx
Web downloadable L . .
2 software tools FPGA software from the Xilinx and they will provide updates
Website. The registration is done through their standard update
online by the user. mechanisms.

Notel: The installation of Xilinx tools are self guided. Click on the Setup.exe in the directory and
the installation starts.

Note2: Choose the option of cable drivers during the installation of Webpack ISE. If these drivers
are not chosen then the drivers for Platform cable — USB will not be installed in the System.
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Chapter 2
Setting up TLL5000 Base Module

The following picture shows the connections to be made between the PC and TLL5000 Base Module.
Please strictly follow the steps as per the manual to avoid any problems to the hardware. The
wrong sequence of applying power and connection sequence can cause damage to the system.

Power Supply
(18v / 3.5A)

Power ON/
OFF Switch Power

(CON100)
/ USB port for TLL5000
Connection

(CONS01)

USB Cablel

i_-,l e § e et : Bxilinx Cable2
g b b el . s el

FPGA JTAG port JTAG port
(CON1) (From PC to TLL5000
14-pin CON1)

Figure 2-1
TLL5000 platform setup.
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Power ON and TLL5000 Configuration

usi

provided with your system.

ng Hardware Manager

Connect the power supply to the power supply connector — CON100.
Connect the USB cablel between PC-USB port & CON8O01l. This connection is used for
communication and configuration of the TLL5000 from the PC using the TLL software

Switch ON the power supply on the TLL5000 with POWER ON/OFF Switch.
As the power is switched ON, the LEDs near the power connector will turn ON.
Now use the TLL5000 Hardware Manager utility (typically included as a menu selection in

the TLL Design Center software, please consult your local TLL partner for specific directions)
to configure. This will bring up the following screen on the monitor.

@ TLLS000 - Monitor/ Controler

Dizconnected

BoadID |

Ethermet |
Address |

I s S

£ OGS SR R 2B
& I |l
A [T SIS E S AT
e pEke Eantol
= el [HEuts
L | [ 4z
& moz [ 1000000 | AR
= (el [HEuts
| (i Gl
) (Dl 2/ | 10000000 | FAH:
(B et [ a8
PEC ] el e [ g e BT LUty EnEle 1ase iffee g L
Apcessony Port Ck 1 [100.0000 MHz  [Divider Bypassad jl ivider Bupassad j I j Fadl i B I
deceszary Far Clk 2 | 10000000 bMHz  [Divider Bypassed jl Divider Eppassed j [ j g S I
[PECL fezzenine & | 1000000 MHz  [Divider Bypassed) | =] | Divider Bypassad o =] c & | S |
U/RERL Mezzenine B | 1000000 MHz  [Divider Bypassed) |7 ]| Divider Bypassed o E c e 5|
IS e CH G —
M EEZErnE I (000000 MHz  [Drivider Bypaszed ;Il Divides Bypaszed d I Il d o © S O _I.'L
dezzznine & | 100.0000 MHz  [Divider Bypsssed) | =] | Divider Bypassed j [ j e ol e I
FRES | 1000000 MHz  [Divider Bypassed) | =] | Divider Bypassed o = ol o S |
CPLD | 333333 MHz  (Divider 3) =||#3% Ho=1 =2 =||o =] & o | 5= |
Status information [Eomfigur it file
Head W frte |
Figure 2-2

Hardware Manager.
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1. Click on the Choose device option in the step-5 screen, options will be displayed as shown
below:

j TLL500D0 - Monitor/Controles

EEHEENIES]

SR Gl

F o | eiel Bl i

BRLi At ————

Figure 2-3
Selection of target platform.

In the options above we shall see “TLL5000 Development Board”. This option will be enabled only
by connecting USB cable between TLL5000 base module and PC.
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2. Now click on the “TLL5000 Development Board” option in Step-6. The following screen

appears on PC.

EH TLL5000 - Monitor/Controler M= E
Ethsrnet Test
Cornected BoadID | ' P HostIF 57, 168.0. 2 |
|LL-5000 Developrent Board ] P [ON] BoedlP [92 168 0 . © HatDione
— Hiyen sl ves W earar =t [ = R

. | L o & Heard v Eesd
o v 2oy IO oy | | [ | | e oo | G
flz (GO | G9E-1.20% ' 72 W iz vl m fiEa |

= Efrie i e |
AT =2 ALIHE] 0 EnEes
FlEleE el ——— | _ — _ _ IT & Bead
eickl [0 HH i il 2V | [ i s = Wit
oz [T7000000 | HE- | s | [ || Fy] g ||| va o0 ] |
Bt el A a1
/PR )i e i (e IS Rl i L O
Snezrsarpll Ee i J 10000000 BHz  [Divider Bypassed LI Divider Bypaszed j 0 j [ ol He
frereesaaTEar e 2 J 100.0000 bHz  [Divider Bypassed LI Divider Bvpassed j 1] j [l o Sel
[ PEGL Hemranine & J 1000000 B4Hz  (Divider Bypassed L” ivider Bypassed j 1] j LS O} #El _]
ISPEGL Hezzanine B [ 100.0000MHz  [Divider Bypassed) |~ ]| Divider Bypassed =l =] fal o Cek
(/G ard EHEE TR T
Hezzznine B J 10000000 B4Hz  [Divider Bypassed LI Civider Bypassed J [ J e il 'l 3 [
MEZEETnE v] 10000000 BHz  [Divider Bypassed LI Divider Byupassed j [ ﬂ o . ' ol SEL
.""".f‘.l 10000000 BdHz  [Diwider Bypassed L‘I [iwider Bypaszed j [ j L g ]
CRLD | 33.3333MHz  [Divider 3) Zl|33% Ho=1 LE=2 =[]0 =] & Ge
Staus infarmation Corilig.uaion il

{

( |Board Powered Down ) Hesd | e I

Figure 2-4
Checking platform status.

e At this stage the screen displays the status as “Board Powered Down” (see the Status
information marked in blue in the above screen). This means the platform is not powered
up. Once the “Power ON” button is clicked then the platform will get powered up.

[ ]

The power supplies for the various TLL5000 elements (FPGA, memories, peripherals, etc)
are started by clicking on POWER (marked in the red color) in the above screen. Now the
power supply is enabled for all the parts of the board and the screen is shown as below.
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3. The above screen provides monitoring of the TLL5000 onboard power supplies and
configuration of the various user-settable parameters such as the system clocks shown in the lower
tables. For example, the expected voltages and the actual voltages will be displayed in the “Power
Values Monitor” section in the upper left of the display screen.

] TLL5000 - Monitor/Controler M [=] 2
Ethemet Test
Connected Boasd ID | o HostlP  192.168.0.3 =
LL-5000 Developroent Board =] Ethemrst (OFF]
| = BoadIP [ 192 168, 0 . 0 | | NotDane
— Poweer Yalues Monitor FPGEA (R )]—— —CPLD [R/w)
T 1| 4 amns. 15 q + Read i+ Bead
12W 112390 | (140N 126D 33V :mav S G AR 2
B e o Frmv rom e eg |ummnnnm e || "9 00000000 Write
12V |8V oeE 120y vl [M0000000  Read | || val [(¥00000000 ead |
Clocks Control :
JTAG Teding L0951 0 Reqisters
~Chock Inputs———————— * Read
i 000
C ook If‘ MHz | | Sean l:halnl_ Set | UpenHS"-r"Fl T)(] IR l reg |Ox Ve
& Oz | 1000000 MHz Weil TAP Flesell FFX] DR wal I[Iad]l] FRead
Clock Dutputs
LVPECL- Output Frequency [Divides) Dty Cycle Fhagze Offzet Or O
docessory Port Ck 1 [ 100.0000 MHz  (Divider Bypaszed) || Divider Bypassed =0 =] O Sel
Aecessory Port Ck 2 | 1000000 MHz  (Divider Bypassed) 7| | Divider Bypassed =0 =l Co& Set
LWPECL Mezzanine | 1000000 MHz  (Divider Bypassed) x| | Divider Bypassed =lfo =l & S
LWPECL Mezzanine B | 1000000 MHz  (Divider Bypassed) = || Divider Bypassed o =l v | Set
LVD5 and CHMDS
= LVDS CMOS
Mezzanine B | 1000000 MHz  (Divider Bypassed) = || Divider Bypassed Fllo 5le o © & S
Mezzanine & | 1000000 MHz  (Divider Bypassed) ¥ | | Divider Bypassed o =& o & _Se
FPG& | 1000000 MHz  (Divider Bypassed) ¥ | | Divider Bypassed o = C & |5
CPLD | 333333 MHz  (Divider 3) =[x ro=1 wc=z =0 7] &  _S5d
Stafue information Canfigutation file
Clocks set OF Read | Walrite: |
Figure 2-5

Platform power up.
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Setup for Xilinx Platform Cable & TLL5000 Base

Module:

Note: Before connecting the Xilinx Platform Programming Cable from the PC to the target TLL5000,
it is required to complete all the steps of TLL5000 Power ON and Configuration using the
TLL5000 Hardware Manager as explained in the above section.

e When the Xilinx Platform Programming Cable is plugged into the system, the hardware is
identified. This can be verified by right clicking on
My Computer - Properties - Hardware - Device Manager - Programming cables.

_E_,'_ Device Manager

=101 ]

J Ackion  Wiew |J = = |

Computer

--D Disk, drives

@ Display adapters

% Floppy disk controllers
-6 IDE ATAJATAPT cantrallers
% Imaging devices

- Kevboards

(-3 Moritors

Hﬁ Metwork adapters
- 5 Ports (COM & LPT)
Ew Programming cable

-- System devices

Mice and othet pointing devices

i -5l Nlinx Platform Cable USH
--{BE Sound, video and game contrallers

-8 Universal Serial Bus controllers

Figure 2-6

Checking status of the platform USB cable.

e Now observe the color of the status LED on the Platform cable — USB box. It will be orange.
The status will remain orange till the other end of Platform cable — USB (a 14-pin Flat ribbon
connector) is connected to the TLL5000.

14-pin FRC connector
goes to TLL 5000 board
CON1

J

Status LED

IS

Figure 2-7
Checking status checking.

This end goes to
PC USB port
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e Now connect the Xilinx Platform Programming Cable to the JTAG 14-pin FRC connector
labeled CON1 on the lower right of the TLL5000 (this is non-reversible connector with a
notch on the connector long side). Please refer to the following diagram for connections.

CON1

8 EEEENaEE
4 |-_-|| T
- ] T O [ |

Figure 2-8
TLL5000 platform JTAG connector.

e When the Xilinx Platform Programming Cable is connected to the TLL5000 the status LED of the
Platform Programming Cable will turn GREEN indicating that the JTAG communication is
successful with target board.

Note: If the TLL5000 Power ON and Configuration using the TLL5000 Hardware Manager
are not followed, then the reference voltage for JTAG will not be available on CON1 of TLL5000 and
the status LED will remain ORANGE. Until the status LED turns GREEN, the bit file cannot be
downloaded onto the target Platform.
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TLL5000 Interfaces and Peripherals

Audio In RS232 S Video Out RGB IN RGB OUT LCD

Audio Out \ \ | | / /

PS2 Key

Board

Switches

PS2 Mouse

N\

Ethernet &
UsB

MIC In VGA SVideo In NTSC / PAL In NTSC / PAL OUT LEDs

Figure 2-9
Various interfaces in TLL5000.
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Chapter 3
Digital Design using Xilinx ISE

In this section we will introduce the steps needed to create a digital design with the schematic
entry method of circuit design. Schematic entry is often a starting step in learning digital design
prior to the Hardware Description Language approach to digital design, but can also be used
concurrently with HDL approaches when a block diagram or circuit view is the most natural method
of specifying the design. Now let us start with a basic design.

1. Run the ISE application by double clicking on the shortcut icon for the ISE tool or selecting it
from your Programs menu.

Figure 3-1
Invoking Xilinx ISE.

2. When the tool is invoked the following windows will appear in the ISE tool.

[ES Kilinx - ISE =[5
File Edit Yiew Project Source Process Window Help

ID2EF G nExa2a|BI2AX X2 |R[H]%E o)A 8]0 al =]

|5 & & | £ 5% 86 26 5t

=

No project is open

Select:
File->0pen Project
o
File->Mew Project

B3 Sources | Snhapshots I E Libraries I

=

No flow available.

24 Processes I

Figure 3-2
XILINX welcome screen.
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3. Now a new project has to be created. To create a new project, click on the “File” menu and
select “New Project” option.

S Xilinx - ISE
|Ei|e Edit Wiew Project Sou

Mew Project...

Qpen Project...
Cpen Example...
Zlose Froject
Save Project Gs,..

[ Mew Chrl+M
.q" Qpen... Chrl+o

zlose

E Sanve el +5
Save s,

B zave &l

Erimt Presiem., .

\E Erint. Ctrl+F

Recent Files »

Figure 3-3
Creating a new project.

4. When the new project option is selected the following window is seen. In this window type a
project name “buffer_sch” and specify a location. Select “Schematic” as the Top-Level Source Type.
And click “Next”.

[EE Mew Project Wizard - Create New Project

—Enter a Mame and Location for the Project

Froject Mame: Froject Location
@u\ffal__s@ IF:\MenporuI'\HiIinHS‘l “baru_designs31 Sbuffer_sch I

—Select the Type of Top-Level Source far the Project
Top-Lewvel Source Type:

<I ?chematic > LI

taore Info | < Back | MHext » I Cancel

Figure 3-4
Entering the project name.
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5. After these inputs the tool will go to the next window. Here select the target device and the
tools that will be used in developing the design. Then click “Next”.

EE Hew Project Wizard - Device Properties
—Select the Device and Design Flow for the Project

Property Hame ~ rhct -
Froduct Category ol Pt
F arnily Spartanz Il
Device HC251500 Il
Package FGE7E |
Speed -4 vI
Top-Lewvel Source Type Schematic Ll
Synthesziz Tool 5T MWHDLAYerilog) 'I
Simulator todelzim-+<E WHDL 'I
FPreferred Language wHDL 'I
Enable Enhanced Design Summay [V
Enable Meszzage Filtering —
Dizplay Incremental Meszages —

\ y

Mare Info | < Back I Meut » I Cancel

Figure 3-5
Selecting of a device.

6. In the next window, click on “New Source” tab. In the “New Source Wizard” window give the file
name and select the input file type as schematic.

1]

E Mew Source Wizard - Select Source Type == B I

State Diagram
Test Bench WaveForm
User Docurnent

Yerilog Module File: narme:
Yerilog Test Fisture

i WHDL Module Jbuiter_sch
WHOL Library Laocation:

F|WHDL Package
g| YHOL Test Bench

IF:\MenporuIWilinxS'I “bany_designs314buffer_sch

|

W Add ta project

rare Info | < Back | ET S I Cancel |
Mare Infa | < Back || Mext » I Cancel I

Figure 3-6
Selecting a source type.
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7. When the “Next” button is clicked, the “New Source Wizard” summary window will be seen.
Click on “Finish” here.

E Hew Project Wizard - Creat

=10 %]

E Mew Source Wizard - Summary M= B3

| Project Havigatar will create a new zskeleton source with the fallowing specifications: |

Add to Project: Wes

Source Directory: F:AMenporult=iline31“baru_deszign=31%buffer_zch
Source Type: Schematic

Source Hame: buffer_zch sch

¢ Back Finizh Cancel

Fore [nfo I ¢ Back I | Memt > I Cancel I

Figure 3-7
Completing the new source wizard.

8. In the next window click “Yes”, to create the new project directory.
el
I
| Froject Mavigator will create a new skeleton zource with the following specifications: |
Add ko Project: Yes
Source Directary: FukMenporul<ilinal “baru_designs31sbuffer_sch
Source Type: Schematic
Source Name: bulfer_sch.
\cl.?) The directary
'F-5MenporulhxilingS14hbaru_designa91\buffer_zch'
does not exizt. Would vou like to create it?
Mo
< Back I Finizh I Cancel I
Mare Info | < Back | | Mest » I Cancel I
Figure 3-8

Confirming the project creation.
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9. Then click on “Next” in the “New Project Wizard”.

E Hew Project Wizard - Create Hew Souice == e
Create a Mew Sourc
Mew Sourze,.. |
Source File Type
1 I buffer_sch.sch Schematic Remaove I

Creating a new zource to add to the project iz optional. Only one new source can be created with the Mew Project ‘wizard
Additional sources can be created and added to the praject by using the ''Project->Mew Source'' command.

Exizting sources can be added on the next page.

More Info | < Back I Mext > I Cancel

Figure 3-9
Creating a project.

10. Again click on “Next” button on the “Add Existing Sources” window, since at this point of time
there are no existing source designs.

E MNew Project Wizard - Add Existing Sources

—Add Existing Sources

Source File Copy to Project Add Source |

1
Femowve |

Adding existing sources iz ophonal. Additional sources can be added after the project is created using the "'Froject-»4dd
Source” or "Project-»Add Copy of Source" commands.

tdare Infio | < Back | MHest > I Cancel

Figure 3-10
Adding an existing file.
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11.Click “Finish” on the “Project Summary” window, to create the project, or click “Back” to go
back and make some changes, if any.

E MHew Project Wizard - Project Summary

Froject Mavigator will create a new project with the following specifications:

Project:
Project Naune:
Project Path:

Top Lewel Source Type:

buffer_ sch
F:wMenporuliXilinxS1ibaru designsf1Zbuffer sch
Schematic

Model=sim
Preferred Language:

Simulator:

Messsoge Filterinc:

Enhanced Design Suammary:

Dewvice:
Dewvice Familvy: Spartand
Dewvice: xc3s1500
Package: fga?a
Speed: -1
Fynthesis Tool: EIT (VHDLAVerilog)

—¥XE WVHDL
WHDL

enakbled
disabled

||

< Back

| il |

Cancel |

Figure 3-12
Viewing the project summary.

12.Once the finish button is clicked, the project is created and the design summary is also given in
the ISE tool window, as shown below. And click on the file name tab to edit the file, as shown in
the red circle on the figure.

B Xilinu - ISE - F:\Menporul\Xilinxd1\baru_designs91\buffer_sch\buffer_sch.ise - [Design Summary]

=

File Edit Wiew Froject Source Process Window Help

==l >

IR EEEEE A sl ErEr - o e = N =l P 2

=2

ek b= 2-2 (N0 S OA[R T ][] 4 A==

e @ e sest o1 Dl |
x|

Sumbol Mame Filker

[ Translation Messages
- ] Map Messages

- FPGA, Design Summary = BUFFER_SCH Project Status
Categories - Design Overview Project File: buffer_sch.ise Cumrent State: New
<Al Spmbals-—> ﬂ ] Summary Module Name: Buffer_sch « Errors:
A rithrstic [110B Propeties
il = . Tiring Constraints Target Device: wc3s1500-4fg5 76 + Warnings:
Symbols () Finout Report Product Version: | ISE 9.1 « Updated: Mon Apr 23 13:36.44 2007
acclB i’ [ Clack Feport
accd EI-Errors and Warhings | BUFFER_SCH Partition Summary |
i =l [ Synihesis Messages

[ Mo partition infarmation was found

Detailed Report
- [ Place and Fioute Messages T LT
Drientation [ Timing Messages Report Name Status Generated | Errors Warings | Infos
[Rotate 0 | - ) Bitgen Messages Syrihesis Report
S [ - [21 &)l Cunent Messages Z|| [Translation Report
IE’rDiEEl Properties tap Report
g Sources | gy Snapshts| [Ty Libraries| = Symbals || i B Enable Enhanced Design Summary || [Fiace and Routs Report
————l -~ O Ernsble Message Filering Sratic Timing Repart
= | ‘O Display Incremental Messsages 9 e
No fl ilabl Enhanced Design Summary Contents Bitgen Report
© Tlow available. i @ Show Partition Data
O Show Eners
O Showwarmings
{0 Show Failing Canstaints

[ Show Clock Repart

Bf Processes
2 Design Summary (] [ buffer_sch.sch b
x|  started : "Launching Schematic Editor to edit buffer sch.sch"”. -
Started : "Launching Design Swuwmary™.
il | |
[E] Console | @Erors |y warmings Iﬂ TolShell | |gq FindinFiles |
[[20,2728]

Figure 3-13
Viewing project summary in HTML format.
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13.Click on the “Float Window” button to get a better view of the schematic editor. This is the
same as an undocking feature.

1% 8 mE 2 w2
:.G/Dﬂﬂm

Figure 3-14
Undocking the window.

14.Once the schematic editor is undocked, i.e. the window is floated, the following window can be
observed.

B buffer_sch.sch I [] B3
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Figure 3-15
Selecting the components.

In this window click on “Symbols” tab in order to get the various components under different
component categories, in the left side of the window.
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15. From the “Categories” tab in left side of the window, select “buffer” and select the desired
symbol from the “Symbols” tab and place in the editor window, as shown in the figure. The editor
can be zoomed in / out as per the requirement. Notice the grid positions as guides to drawing a
neat layout.

IHo [ oo 2O XXBRAN|[daph-2/2-8[N0 /L

|

T Options

D Symbols |

[ Select Options
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T e v i hieen :::::::::::::::::::::::::::::::\:\;1'“.‘:::::::::::::::

" Keep the connections to S e [
ather abjects e = 0 L
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other objects A =1 | =S

Whenvouusethe areaselect [f| - - - - - o o oLl ETRUR
toal, select the objects that

* A enclosed by the area

7 |ntersect the ares

When you uze the area select

Figure 3-16
Placing the components.

16. After placing the components, the wire has to be connected. To connect the wires right click in
the editor, select “Add” select “Wire”.
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Paste Lt =l |5

Faste Special. ..

. Celete o
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Ea=l=layl g Met Marmes Lod 0 B e}

Select and Clear L Bus Tap Ctrl+- B

Object Properties Alt+Enter I PMarker Crrl4- S

Zywmbol [t L TR T |
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o
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Line el L

Rectangle

Te=xt e+ T

Figure 3-17
Adding wires to the components.
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17.Now as shown in the below given figure, add the wires to the components, in the editor
window.

- o
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= . I &1
THUF
= s &
CEUE
= - 1"
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=
= =
TBUFE e
= Lo e
-~ BUF

Figure 3-18
Placing wires.

18. After adding wires to the components, the 10 markers are to be added to the wires, which
should be used for applying the inputs and monitoring the outputs. To add 10 markers again right
click in the schematic editor, select “Add” and select “1/0 Marker”.

Print Current Sheet

Pop to Calling Schermatic

Previous Wiew

Mext Yiew

Zut: Tl
Copy Chrl+ &
Paste Tl

Paste Special.,.

Delete L
Zaarm L4 Met Mame
Select and Clear + Bus Tap
Object Properties Alt+Enter I/0 Marker
Syrmbaol
Figure 3-19

Adding 1/0 marker.
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19.Place the 10 markers as shown in the figure. While placing the input marker select “Add an
input maker” and for the output marker “Add an output marker” in the options window on the left
hand side of the window.

o O D e N

P e OTE
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o TR
ffff::::::::fffffffff.@?ffffffffff::::::::fffff

Figure 3-20
Renaming 1I/0 markers.

20.To edit the object properties of the 10 markers, in the name field delete the existing name and
give the desired name, and click “OK”.

B object Properties x|

Category

el M arme Walue Wizible | Me
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Delete
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Figure 3-21
Renaming the markers.
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21.Repeat the same for all the ports. Save the schematic. Next perform a “Check Schematic”
function has to be done. This same as check syntax process, in the text based design entries.

..-L.i..aa

: :|Eheck Schemath:l: :

Figure 3-22
Checking the schematic.

22.Observe the “No error or warning is detected” message in the console window as shown below.

x|

Start DRC
No error or warning is detected

4| |
£| Cansale ﬁ Emor |\ “warning

Figure 3-23
Observing console window.

23. Then dock the floating window by clicking on the “Dock Window” button.

=

. -|D|:u:k thiz window| -

Figure 3-24
Docking the window.

24 Copyright © 2007 The Learning Labs, Inc.



TLL5000 Electronic System Design Base Module Getting Started Manual, v3.2

24.Then click on the “Sources” & “Process” tabs in the ISE tool window. Select the option as
“Behavioral Simulation” in the “Sources for” window.

Xilinx - ISE - F:AMenporul'Xilinx91\baru_designz91\bufig

&. File Edit “iew Project Source Process add Tools
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':Eﬂ buffer_sch
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= |

Frocesses for wc3ds1500-4fgE7E I
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-%F  Design Utilties

4 Frocssses o Options |

= Desigr

Figure 3-25
Selecting the simulation option.
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25. By selecting the input file name in the “Sources for” window, expand the “ModelSim Simulator”
window from the “Process for” window and run the process called “Simulate Behavioral Model”.
This will invoke the simulator that we use to simulate the design. Here ModelSim XE 6.2c is the
simulator used.

lE]'MudeISim XE III/Starter 6.2c - Custom Xilinx ¥ersion
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‘TJ. i 1 buf{buf_v]  Architecture +aco=4..., -
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Figure 3-26
Forcing the input signals.

26. Force the selected input signals with the desired values, and click on “OK”.

[

Force Selected Signal x|

Signal Mame: |Sim:.-"I:uuffer_sch.-"l:uuffer_in'l

Walue: [1]
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Drelay For; |EI
Cancel After: |

ok LCancel

Figure 3-27
Docking the window.
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27.Then click on “Run” button, in order to view the simulated results.

GOEIG: & &

E| ||Hunt3:

Figure 3-28
Run simulation.

28. The simulated results can be seen in the wave form window. The vertical yellow bar is the
cursor. Wherever the cursor is placed, the corresponding values will be displayed in the wave
window, as marked in the below shown figure. Different inputs can be applied and the output can
be viewed accordingly. Once the satisfied output is got the simulator may be quitted.
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4
4
4
4
4
4
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4
4
4
4
4
4

buffer_outd

Figure 3-29
Viewing the simulated output.

29. The next step in the FPGA design flow is to synthesize the design. Synthesis is the process that
generates the equivalent gate level netlist for the input design file. The netlist is a text based file
that contains the details of the devices and the interconnection network that are used in the
design.

30. In order to run the synthesize process, select “Synthesis/Implementation” option in the “Source
for” tab, and right click on the “Synthesize — XST” process, in “Process for” window and select
“Run” from the pop-up menu. Once the synthesis is completed, expand the synthesis process to
view the synthesis report, RTL Schematic & Technology view of the given design.
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31. The above processes are shown below.
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Figure 3-30
Synthesizing the design.

32. The next process is the implementation process. This process has three major steps under it.
They are (a) Translate, (b) Map and (c¢) Place And Route.

Translate:
Translate is the process that merges all the input files and the constraint file into a single netlist.

Map:

Map is the process that maps the logical components to the physical components. Logical
components are the ones which are there that according to the circuit diagram. And, the physical
components are the ones that are physically present inside the FPGA.

Place And Route (PAR):

The map output file will be taken as the input file for the PAR process. The map file will contain how
many CLBs & I0Bs are required to implement the design. And also it will have the details of which
are the CLBs & I0Bs that are used in the design implementation. Based on that information, those
particular CLBs and 10Bs will be configured. This process is called as placing, and the routing is the
process which makes the interconnection CLBs and/or 10Bs.

33.Before going to the process of implementation, it is necessary to write the user constraints
(ucf) file. This is the file where the designer can give the constraints for the design to be
implemented.
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34.To enter an ucf file, click on “Project” menu and select “New Source” option.
EXilinx - I5E - F:AMenporulXilinx91\baru_designz91 \buff

L. File Edit Wiew | Project Source Process Add Tools
ID*E&G|E

JJEJ rﬂ"“ M [ E@IE Add Source... abe
add Copy of Source...

Sources fu:ur:l Synthesis Zleanup Project Files

1= buffer_sch Toggle Paths
B~ E;E HC3SL5D|:|-4|:QE T,
@ﬁﬁbuffer_s

Take Snapshot...
Make Snapshot Surrent

apply Project Properties. ..

Source Control 3

Figure 3-31
Creating a new source for constraints file.

35.0nce the new source is selected, the “New Source Wizard” window gets opened. Here, enter
the file name and select the input file type as “Implementation Constraints File” and click on
“Next”.

E Mew Source Wizard - Select Source Type M=l
BkM File
'{] |P [Coregen & Architecture “Wizard]
%] MEM File
| Schematic
| B8 [mplementation Constraints File
% State Diagram File name:

1| Test Bench W aveF orm Ibuﬂer ooh
Jser Document =

v | Werlog Module Location:
Wil Werilog Test Fikture
"y WHOL Module
WHOL Library

P |WHDL Package
gl WHDL Test Bench

IF:\MenpnruI\XiIinﬂEﬂ “baru_designz31sbuffer_sch . |

¥ Add to project

Mare Info | < Back | Mext = I Cancel

Figure 3-32
Synthesizing the design.

36.When the next button is clicked, the “Associate Source” window gets opened. Here select the
appropriate entity/file name. If only one file is added to the project, then by default the same is
selected. If more than one number files are there, only then we need to select the file/entity name.
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37. Select the file (entity) name and click on “Next”.

S New Source Wizard - Associate Source

|Select a source with which to associate the new source,

Mare Info | < Back | Mezt » I Cancel

Figure 3-33
Selecting an associated source.

38. Then again click on the “Finish” button. If any changes are to be made, click on “Back” and
make the required changes.

E Mew Source Wizard - Summary M= E

| Project M avigatar will create a new skeleton source with the following specifications: |

Add to Project; res

Source Directory: F:\Menporuliiling31 \baru_dezigne31 \buffer_sch
Source Type: Implementation Constraints File

Saource Mame: buffer_sch.uct

Azzociation: buffer_zch

< Back Finizh Cancel

Figure 3-34
File summary.
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39. When this is completed, the ucf file is created and added to the project. To check this click on
the + sign beside the input file name in the “Sources for” window. In this example design, the pin
constraints will be in the ucf.

& Xilink PACE - F:\Menporul\Xilinx91\baru_designs91\buffer_schibuffer_sch.ucf
File Edit WYiew IOBs Areas Tools Window Help
[D2E [ E|o nsegaiessgdomsme | Kaasan 00 DNEECENR
M [m[ 3| i Device Architecture for xc3s1500-4 o =] ]
[l 3
B Design Obije D P _[a] =
170 Name| 170 Directionf Lo Bank| 170 5td.
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IM2 Input hE] BAME
IM1 Input 8 BAME
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OUTT  [Ouput Y1287 | [BANK
ouT4 Output a3 [BANK
41 | 4 Packaye View A Architecture Yiew f 4 | » d
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Figure 3-35

Assigning pin numbers.

40. To give the pin constraints, select the ucf file and expand the “User Constraints” in the “Process
for” window, and run the process “Assign Package Pins”. This will invoke another XILINX — built in
tool called PACE (Pinout Area Constraint Editor).

41.Enter the pin numbers, where the inputs and the outputs are supposed to be connected. The
details of these pin numbers, may be found in the user manual.

42. After entering the pin numbers, the save the file and PACE tool may be exited.

43. Then again select the design file in the “Sources for” window.
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44.The next step is to run the implementation process. So, right click on the “Implement Design”
rocess and select “Run” from the pop-up menu.
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Figure 3-36
Implementing design.

45. During the project design of a digital system each process can be found in some of the following
states

) Running — the process is in the running phase.

Up-to-date — Process is successfully executed without mistakes or warnings. If the rapport is in
this condition it means that it's up to date although it could happen that the tasks covered with this
process have mistakes and warnings.

AN Warnings reported — the process is successfully executed but there are warnings.

@' Errors reported — the process is finished with at least one error.

@ out-of-Date — signifies that there have been made some changes and that the process needs to
be done again.

No icon — In the case of, there is no any of these icons the process hasn't been started.
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46. After the design implementation process is complete, the programming file needs to be created
to download into the FPGA to correctly configure it. To generate the programming file, run the
rocess called “Generate Programming File” from the “Process for” window.

EXilinx - ISE - F:AMenporul'Xilink91\baru_designs91\buffer_schibul
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Figure 3-37
Generating bit file.

This process will generate the programming file. i.e., the bit stream file will be generated. This is
the file that will be downloaded onto the FPGA.

Once the file is generated, the next step is to make the communication between the host system
and the target TLL5000.
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47.Before starting this process, “Power ON” the board as given previously. To make the
communication, expand the “Generate Programming File” process and select the “Configure Device
(iMPACT) process.
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Figure 3-38
Configuring the target device.

48. Before running the process “Generate Programming File” right click on “Generate Programming
File” and select “Properties”. In the properties window, select the “start up Options” and set the
value as “JTAG Clock” in order to avoid the warning messages in the future.
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49. This opens another software tool called iMPACT. Click on “Finish” button, in this window.

ES iIMPACT - Welcome to iMPACT =l
—Please selzct an action from the list below
* Configure devices using Boundary-Scan (I TAG]
I Automatically connect to a cable and identify Boundary-Scan chain ;I
= Prepare a PROM File
= Prepare a System ACE File
= Prepare a Boundar-Scan File
SWF e
= Configure devices
uzing Slave Serial mode j
< Back | Cancel

Figure 3-39
Checking for boundary scan devices.

50. This process detects three different devices that are present on TLL5000 target. The “xcf32p” is
the flash device, “xc9572” is the CPLD device and “xc3s1500” is the FPGA device.
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Figure 3-40
Selecting the target device.

51. The “Assign New Configuration File” is place where the programming file will be browsed to the
location and selected, by clicking on the “Open” button. But, here DO NOT!! Select or configure the
flash device and the CPLD. So, click on the “Bypass” button to bypass these components. And
finally when the FPGA is highlighted, select the generated bit file, and click “Open”.

Ol ‘i_é 0w f A Exum | ﬂ
*cf32p wCIET2x] #c3s1500
bypass bypazss --- file ¥ ---
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i
Figure 3-41

Selecting the bit file.

52. After completing this process, the bit file will be selected for the FPGA, to be programmed.

i f i f i f
LS T N ¢ T S T (—
*cf32p e T xo3=1500
bvpass bypass bhuffer_sch bit
TDOD
Figure 3-42

Selecting the bit file.
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53. Now right click on the FPGA,

and select “Program” from the pop-up menu.
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Figure 3-43

Programming the device.

54. In the “Programming Properties” window, just click on “OK”.

E Programming Properties

Categary

=8 Programming Properties
Advanced PROM Programming Properties
= Hevizgion Properties

™ Werify
—General CPLD And PROM Properti

I | Erase Before Programming [T | Bead Pratect

™ | PROM/Coolfunnerl Usercode (B Hex Digits] I

—CPLD Specific Properties
I™ | wiite Protect | Funchional Test [ On-Tke-Fl Progran

I | %PL& UES Erter up ko 13 characters I

—PROM S pecific Properties
I | Load FRGE, [T RarallelMade [T Wse D4 for, CF

—FPGA Device Specific Programming Properties
I” Pulse PROG [~ Program fey

— Spartan2AM Pragramming Froperti
I | Diata Pratect [T Data Lockdown

QK I Cancel Apply Help

Figure 3-44
Programming the device.
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55. The program status can be observed by the viewing the “Progress Dialog” box.

;-hhhhhl: ;-hhhhhl
TOl — AEwumcf A souwr
- i -
xcf3zZp *CHST 2= xoa=z1a00
bypaszs bypass buffer_=ach bit

oo —— E Progresz Dialog [24%] 7| x|

E xecuting command...

i 24%

Figure 3-45
Downloading the file.

56. Once the device is program is downloaded, the “Program Succeeded” message appears.

L ¢TI S T —
xcta2p xC9ET 2k xz3=1500
bypass bypazs butfer_sch hit
T
g lucceeded
Program Succeedec
Figure 3-46

Viewing status message.
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Functional Test on the TLL5000

The design downloaded onto the TLL5000 is tested for correct functionality with the use of switches
and LEDs available on the target TLL5000.

TLL5000 Rev 1.1

" copyright 2006.

Figure 3-47
Observing the outputs.

As the switches are toggled to ON/OFF positions, if the design is functioning correctly then the
corresponding output LEDs will turn ON/OFF to match the switch positions.
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Chapter 4
Digital Design Using VHDL

1. To invoke the ISE 9.1 tool, double click on the below shown icon, on your desktop.

T

silirs 15E
.11

Figure 4-1
Invoking XILINX tool.

2. Once the tool is invoked the below shown window will open.

[ES Xilinx - ISE (O] x
File Edit Wiew Project Source Process ‘Window Help
ID2E& LdaEX=e|H2LX KPR S @5~ R[] =[]

EREAENEE R

=

No project is open

Select
File->0pen Project
o

0
File->Mew Project

B8 Sources 15 Snapshats |E Libraries

=

No flow available.

E—t Processes I

=

4 |
Console | @ Enos | ¢\ Wernings | @ TelShel | g Findin Files |

Figure 4-2
Tool welcome screen.
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3. To start a new project, click on “File” tab and select “New Project”. The same is shown in the
below figure 4-3.

[ES Xilinx - ISE

File Edit Wiew Project Source Process Window Help

X a2 P

Qpen Project.., j

Open Example... |

Close Project en
Save Erolest Ay

[ mew Ctrl+n
13’ Open... Ctrl+0

Close

E Save CHHl+5
Save Bs...

& save Al

Erint Erevie i 5 Libraries I

iEy Print.. Ctrl+P
|

Recent Files 3

Recent Projects 3

Exit

Figure 4-3
Creating new project.

4. When “New Project” is selected a new window is opened as shown in the figure. In the “Project
Name” field enter the desired project name. Now, it can be observed that a folder is created with
the same name in the “Project Location” field. This is for keeping track of all the input & output
files in the same location.

B ilinx - ISE =

File Edit \iew Project Source Frocess Window Help
ID*EFLMEEX Ba|R2AXNEAB[A]BE oA R0 & K
B R T

No project is open

_ Select [EE New Project Wizard - Create New Project (0] %]
File-> Open Project

—Enter a Name and Location for the Project

o
File-New Project
llE=+Mew Prajec P Project Location

w / |F:\menporu|\><ihnx91 htest_project

—Select the Type of Top-Level Source for the Project
B8 Sources ) Snapshots @ L | ToplevelSource Type:

[FoL |
No flow available.
2 Pracesses I Mare Info | ¢ Back | Next > I Cancel

Figure 4-4
Entering project name.
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5. Let the “Top-Level Source Type” be as HDL itself. After giving the necessary inputs and clicking
on “Next” the next window appears. This is the place where the target hardware & necessary tools
are selected. Key in the inputs as per the requirements. Then click on “Next”.

E Mew Project Wizard - Device Properties

—Select the Device and Design Flow for the Project
Property Name Walue
Product Category Al
F arnily Spartan3
Device +C351500
Package FGEYE
Speed -4
Top-Level Source Type HDL
Synthesis Tool #ST WHDLAerilog)
Simulatar ModelSim-XE VHDL
Preferred Language WYHOL
Enable Enhanced Design Summary [V
Enable kezzage Filtering —
Dizplay Incremental Meszages —

tore Info | < Back | Mest > I Cancel

Figure 4-5
Selecting target hardware.

Note 1: The Simulator Chosen — ModelSim—XE, Synthesis Tool — XST (this is the built-in Webpack
ISE)

Note 2: The device, Package and speed are chosen based on the details of an FPGA chip on the
TLL5000.

XC351500-4fq676

XC — Xilinx Component.

3S — Device Family, in this example, it is Spartan 3 Family.

1500 - Device Gate density. As per this example, 1500 kilo gates are present in this chip.
-4 — Speed Grade.

FG — Package type. Fine-pitch Ball Grid Array.

676 — Number of 1/0s on the chip.
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6. To create a new source, click on the “New Source” button.

[ES Mew Project Wizard - Create New Source =00 x|

Create a Mew Sounc
Mew Source... |

Source File Type

|

Creating a new source to add to the project iz optional. Only one new source can be created with the Mew Project Wizard,
Additional zources can be created and added to the project by uging the "'Project->Mew Source' command.

Exigting sources can be added on the next page.

More Info | < Back | ext > I Cancel

Figure 4-6
Creating new source file.

7. When the “new source” button is clicked give a file name for the input source code, and select
the file type, from the left hand side list. In this example it is a VHDL module.

% Mew Project Wizard - C o ] A
E Mew Source Wizard - Select Source Type =] EL

’:[ IP [Coregen & Architecture wizard)
Schematic
<+ State Diagram

| Test Bench WaveForm
=| Uszer Document
v | Werilog Module File name:
U'-.-' Yerilog Test Fisture Ihuffer_E!
II Hy
WHOL Libram Location:
F|WHDL Pack
A YHOL T:Zt Bagjch IF:\menpDruI\.‘Pa'iIim-:S'I ezt project _I

[+ Add to project

tare [nfo < Back | Meut » I Cancel |

tore Info ¢ Back ” et I Cancel |

il

Figure 4-7
Selecting file type.
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8. After giving the file name & file type, the input and output port list of the design has to be
given. Port list is the top level entity of the design. After giving the port names the directions of
the ports can also be entered as per the design requirement. If the port is a type of bus, that can
also be entered, along with the number of bits specifying the width of the bus.

E Mew Project Wizard - Create Mew Source o =] |
E Hew Source Wizard - Define Module =1 S

E ntity Marme Ibuffer_S

Architecture Mame IB ehaviaral

Port Hame Dlirection M5B L5E =
a in 7
b out 7
| in
in
in
in
in
in —
in
in Rd

Mare Info | ¢ Back | Mext » I Cancel |
Mare Info | ¢ Back ” et » I Cancel I

Figure 4-8
Enter the port list.

Note: The Port names to be entered in the above window shall also be 1 bit for typical logical gate
implementations. In the above design we have taken an input port of 8-bits (0O to 7) & output port
of 8-bits (0 to 7).
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9. After giving those details, click on “Next” & “Finish”.

E Mew Project Wizard - Cre - IEI|5|
EE New Source Wizard - Summary =

| Project Mavigator will create a new skeleton zource with the following specifications: |

Add to Project: Yes

Saurce Directony: F:Amenporuleilingg1 Stest_project
Source Type: YHDL Madule

Source Mame: buffer_8 vhd

Entity Mame: buffer_8

Architecture Name: Behavioral

Port Definitions:
a Bus: 7.0 in
b Bus: 7.0 out

¢ Back | Finigh I Cancel |
Mare Info | < Back ” Meut > I Cancel I

Figure 4-9
File summary.

10. After clicking on Next, the tool will ask for the confirmation of creating a new folder. Simply
“Yes” can be clicked. This will create a folder named as the project name, in the specified location.
And based on the information that is given, a skeleton of the VHDL file is created which will have
all the declaration parts of the file. This is common for all the VHDL files.

[E= New Project Wizard - Creal uice =l

ES Mew Source Wizan 1= =]

| Project Mavigatar will create a new skeleton source with the fallawing specifications: |

Add to Project: Yes
Source Directory: F:\menporul’ilingS1 htest_project
Source Type: WHOL Module

Saurce Name: bufer_8.vhd
Entity Marme: buffer_8 P The directary
Architecture Mame: Behavioral k:()
Port D efinitions: 'F:Amenporulhiiinga1 sest_project’
a Bus: ¥.0
b Bus: 70 does nat exist. Would you like to create it?

< Back | Finish I Cancel |
are |nfa | < Back | | MNewt > I Cancel I

Figure 4-10
Creating project directory.
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11. Click on “Next” in this window.

E Mew Project Wizard - Create Mew Source

Create a Mew Source

ew Source. . |

Saurce File Type
Remove |

1 hutfer_8. whd WHOL Module

Creating a new zource to add to the project iz optional. Only one new source can be created with the Mew Project ‘wizard.
Additional sources can be created and added to the project by uzing the "Project->Mew Source' command.

Esisting sources can be added on the next page.

tare Infio | ¢ Back | Mewut > I Canicel

Figure 4-11
Creating new source.

12.Since a new project is being created, it is not required to add any existing source at this point
of time. So, click on “Next”.

E Mew Project Wizard - Add Existing Sources

—&dd Eristing Sources

Source File Copy to Project Add Source |

]
Femove |

Adding existing sources iz optional. Additional sources can be added after the project iz created uzing the "Project->Add
Source'’ or "Project-»Add Copy of Source' commands.

Mare Info | < Back | Pent > I Cancel

Figure 4-12
Adding existing file (if any).
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13. The summary is created based on the information that is given so far. Now click on “Finish”.

E New Project Wizard - Project Summary == E3

Praoject Mavigatar will create a new praject with the following specifications:

|»

Project:
Project Name: test_project
Project Path: FiimenporuldXilinxS1htest_project
Top Lewel Zource Type: HDL

Device:
Device Family: Spartand
Device: xe3s1500
Package: fge7E
Speed: -4

Synthesis Tool: ST (VHDL/Verilog)
Simulator: Modelsim-3E VHDL
Preferred Language: VHDL

Enhanced Design Swmmary: enabled
Message Filtering: disabled LI

< Back | Finish I Cancel |

Figure 4-13
Viewing project summary.

14. Figure 4-14 shows the VHDL file for, the given design. Normally, whenever the file is generated
it will contain the library declaration, port declaration & architecture declaration. Only the
functionality of the design has to be entered by the designer. This simplifies the job of the designer
and time is also saved.

Exilinx - ISE - F:Amenporul'Xilinx91\test_projectitest_project.ise - [buffer_B8_ vhd]

m File Edit WView Project Source Process Window Help =& =
DEEe L ExX[ewae B2 B[ E A% B o o]A w[]om ] =l
I @ @ [ SRR OO 22 sn% 0¥
= 15 -— Revision: ;I

Sources fUr.ISynlhesis!lmplemenlaliun LI 16 -- Revision 0.01 - File Created

T _ 17 —-— bhdditional Comments:

"51 test_project 15 __

E £ xels1500-4fa676 iy

- gl buiffer_8 - Behavioral [buffer_B.vhd] 20 library IEEE;

z1 use IEEE.STD_LOGIC_1164.4LL;
Z2 use IEEE.STD_LOGIC ALRITH.ALLL:
e use IEEE.STD_LOGIC UMNSIGMED.ALL;

21
25 ———— Uncomment the following library declaration if instantiating
zZa —— any Xilinx primitives in this code.
27 —=library UNIZIM;
g Sources ﬁgSnapshots I @Libraries I Z8 ——use TMNIZIN,VComponsents.all:
29
=l 30  entity buffer 8 is
Processes for: buffer_8 - Behavioral 31 Port [ a : in STD_LOGIC _VECTOR (7 downto 0);
T 32 b : out STD_LOGIC_VECTOR (7 downto O));

Add Existing Source - end burfer s:

Create Mew Source 34
Wigw Dissign Summary 35 architecture Behavioral of buffer 8 is
Design Utilities

User Constraints
Synthesize - ¥5T
Implement Design
Generate Programming File

end Behavioral;

-
I ]
< | »
4 Processes I
buffer_8. vhd | i, Design Summary |
x| Started : "Launching ISE Text Editor to edit buffer &.vhd". ;I
Started : "Launching Desigh Sunmarey™.

=

< | o

=| Conzole I @Ermrs I &Wamings IETCISheII I (4 Find in Files I

[Lr 41 Col1e ICaPS INUMISCRLIVHDL - .

Figure 4-14
Tool generated VHDL file.
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In the above window the IEEE libraries are included by default, the design b_<= a; is entered by
the user. This code will act as a buffer where the value of a is loaded to b (all the 8-bits).

15.As per the design flow, after design entry the 1° step is to simulate. So to simulate, the
simulation option has to be selected. The steps for selecting it, is shown in figure 4-15.

Behavioral Simulation of the Design

16. When the design is ready, choose the Behavioral Simulation option (This option is available on
our top left hand corner of your ISE — near Sources for)

Exilinx - ISE - F:imenporulXilinx91\test_projectitest_project.ise -

E File Edit Wiew Project Source Process window Help

IMDFEG LD BX @ H]2 20X
e = @ [ stledle | = =
=l

15 —— Rew
Sources for: | Synthesiz/lmplementation vI 15 -— Rew
. - - 17  —- &add
b 157 test | Synthesis/Implementation
. | ey —Tr——— 15 -
B ehavioral Simulation
19 -

: Fost-Tranzlate Simnulation
Fozt-tap Simulation
Post-Foute Simulation

=Z0 librar-
=1 use IE
=2 use IE
=23 use IE

P

25 ———- 1

26 ———— &

27  ——libr:

Erg Sources I 1P Shapshots I |E Libraries I 28 ——use
9

=l 30 entitcy

Proceszes for: buffer_8 - Behawioral g;— Fo:

= Add Existing Source g end

= Create Mew Source 34
= Wiew Design Summary 35 archit
i-3F  Design Utilities 36
+-F  User Constraints 37 becin
Figure 4-15

Selecting simulate operation.
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17.Then select the VHDL file in the source for window and run the “Simulate Behavioral Model
Function”. To run any process, select the appropriate process and press enter or double click the
process or right click on the process and select run option from the pop up menu.

EXilinx - ISE - F:\menporul'Xilink9d1itest_projectitest_project.ise - [buffe

m File Edit Wiew Project Source Process ‘Window Help

DA [ DEX[@a QP LH XM

| @[S EEAXOD[[er[ = 52
x|

15 —— Revision

Sources for:l Behavioral Simulation LI DE - Revision

H 5 17 —— Additieon
'E':j test project 15 __

Bl £ #c3:1500-40576 -

[l buffer_8 - Behaviaral [buffer_8.vhd) 20 library IEE

a2l use IEEE.3T
22 use IEEE.ST
23 use IEEE.ST

Z4
25 ———-— TUnookin
26 ———- any Hi
27 —=library U
Eg Sources | i Snapshots I |E Libraries I 28 |--use UNISI
29
x| 30 entity buff
Processzes for. buffer_8 - Behavioral I I Fort
H " 32
[ &dd Existing Source 33 end buffer
[  Create Mew Source 34 -
E‘g‘ ModelSim Simulator 35 architectur
Y Simulate Behavioral Model a
N
Rerun
gt Rerun All
2 stop rio

Cpen Without Updating
E“—I: Processes I -
%"{: Properties... De

Figure 4-16
Simulating the design.
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18. The simulator used here is ModelSim-XE from Xilinx. Once the process is started, the simulator
tool is invoked. The simulator main window and the wave window are opened. As, shown in the
below figure.

Iﬁfh’ludelﬁim SE PLUS 5.8¢c
File Edit ‘iew Compile Simuolate Tools Window  Help
[SRe||S=aH || # i w-ElEE B
Workspace |
¥ It Tizgi it |Desi ith # Reading F:/Menporul/FPGADYEILS PS Modelech ol fvsim//pref bel
s L | = | T | ! # /¢ ModelSim SE 5.8c Mar 01 2004
J ] buffer_38 buffer_8[be... Architecture i
W std_logic_unsigned std_logic_un... Package # /¢ Copyright Model Technology, a Mentor Graphics Corporation compary, 2004
- o i) &l Rights Reserved,
Bl 1 logi_ath std Iogic_aith Package #07 UNPUBLISHED, LICENSED SOFTWARE.
B std_logic_1164 std_logic_1... Package #//  CONFIDENTIAL AND PROPRIETARY INFORMATION wHICH 1S THE
B standad standard Package #/¢  PROPERTY OF MENTOR GRAPHICS CORPORATION OR ITS LICENSORS.
t/
tt do {buffer_2.fda}
# = Wamning: [vlib-34] Library already exists at "work”,
# Model Technology ModelSim SE woom 5.8c Compiler 200403 Mar 25 2004
# - Loading pack age standard
# - Loading package std_logic_1164
# - Loading pack age std_logic_arith
# - Loading package std_logic_unzigned
#t - Compiling entity buffer 8
1 - Compiling architecture behavioral of buffer_8
# waim ik wark, -+ 1ps buffer_8
# Loading F:'Wenpol\ FPGADVEILSPS Wodektechiwiind2y.. f2td. standarnd
# Loading F:Wenpol\ FPGADVEILSPS Wodeltechiwiind2/. feee. std_logic_1164(body]
# Loading F:Wenporl\ FPGADVEILSPS WodektechiwiindZy.. fieee. std_logic_arith(body]
# Loading F:Wenpol\ FPGADVEILSPS Wodektechiwiind2/. feee. std_logic_unsigned|bo
# Loading wark. buffer_8[behavioral)
# wave
File Edit Wiew Insert Format Tools  Window
2@ sm@n|| ki Xk ||Na Q] alkx|F
Shufer_ LU C ...
SBuff b JuUULULL
Library | sim | Files 4] 2K [ -]
- Opstolns
|Nuw: 100 ps Delta: 0 |S|m:fbuﬁer_8 | P |
Figure 4-17

Compiling and simulating.
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19. Now maximize the wave window and right click on the input signal and select “Force” from the
op-up menu.

- wave - default
File Edit View Insert Format Tools Window

[ZE8 || s L@ by ||} a) Q]R3 || HiE

/buffer_8/a NN 0.
Jhuff Object Declaration 0.

Wiew Sszertion
Radix
Fomat

Cut
Capy
Paste
Delete

Insert Divider
Inzert Breakpoint

MoForce

Clock...

Properties...

Cursor 1 0ps
< [ [ |
| 0 ps to 2860 ps |

Now 100ps | 500 1ns 1500 2ns 2500 I

/|

Figure 4-18
Selecting Force option.
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20.When in the “Force Selected Signal” enter the desired value for the input signal(s) and click
“oK”_

-=: wave - default

&l
File Edit Wiew Insert Format Tools  Window

Jw@ $BEA[ N KT ||X o€ Q@B [l

Force Selected Signal

Signal Name: lsim:ﬁhuffer_ﬂfa

Value: 01010101

Kind

& Figeze " Dive  © Deposi

Delay For: 0
Cancel After

ok Lancel

| 0 ps to 2860 ps ‘

Figure 4-19
Forcing the input signals.

21. After forcing the input signal, click on the run button. The shortcut to the run button is encircled
in red color in the below shown figure.

File Edit “iew Insert Format Tools  indow

[ZES|| s @M || b Kie |[[X a) Q&R || 2wk

ol buffer_B/a L|L|L|L|L|L|L|L| U
Aouffer_8/b

Figure 4-20
Run simulation.
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22.0nce the simulation is run the output for the given input can be observed in the wave window.
This is known as functional simulation in which only the software code is simulated prior to the
design being implemented directly on the hardware.

=+ wave - default
File Edit Wiew Insert Format Tools Window

SHS|| s@a|| b Xl || AQiQQ@p||EFiElEEH

'I:.urr 3 ||‘|||1||1||1 JuugJuuy 0070701
Abuffer_84b Wy s TN Mmoot

Figure 4-21
Viewing the simulated waveform.

Synthesis of the Design

23.The next step after simulation is to synthesize the design. Synthesis is the process which will
generate the gate level netlist of the design. In order to run the synthesis process the selection has
to be changed as “Synthesis/Implementation” in the sources for window. This netlist output file will
be the input file for the implementation process.

EXilinx - I5E - F-\menporul'Xilinx31\test_projecttest_project.is
m File Edit Wiew Project Source Process Window Help

IR @@XIW@’I.M&"—""&'*

uuwu[@@t@t@c@tluaalu< E

15 -— ERe

16 -— BRe

17 -— Aic

15 -
. Post-Tranzlate Simulation ;‘3 1;};;;
Paost-tap Simulation

Post-Foute Simulation BL Rkl

22 use 1

Z3 use 1
24

259 -———

26 ————

27 —-—1ik

EN3 Sources | ] Snapzhats I |E Libraries I 28  --use
29

2l 30 entit

Processes for: buffer_8 - Behavioral I ;;‘ E

I:l Add Esisting Source 23 end k
=™ Create New Source _

Figure 4-22
Selecting synthesis option.

The progress of the Synthesis process will be shown in the console of the ISE (Left-down corner).
In case of any errors, the details of the errors will be displayed. With any type of error, the design
will not proceed to the Implementation stage. The synthesis generates the synthesis report, RTL
schematic, Technology Schematics. The user should verify these reports in order to understand the
actual logical circuitry that will be configured in the FPGA.
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Implementation of the Design

24.The implementation process has three different sub-processes in it. They are Translate, Map,
and the third is Place & Route.

Translate:
This is the process that merges all the input files and the constraint file into a single netlist.

Map:

The process of mapping the logical components to the physical components is known as Map.
Logical components are nothing but the components that we have as per the design circuit
diagram. Physical components are the components that are there inside FPGA such as LUTs,

gates, flip-flops.

Place And Route:
This is the process of configuring the appropriate CLBs &

interconnecting them. Also known as, PAR.

I0OBs inside the FPGA and

25.To do the implementation process, the constraints file has to be given as another input file. To
create a new user constraint file (ucf), click on project from the ISE software and select new
source. Once that is completed the window shown below appears. Select implementation constraint
file and give the desired file in the file name field. Then click on “Next”, “Next” and “Finish”.

E Hew Source Wizard - Select Source Type M=

[ ) EMM File

] |F [Coregen & Architecture YWizard]
"t MEH File

L| Schematic

|| BM |mplernentation Congtrairts File
% State Diagram

| Test Bench "W aveFam II:uuffer 5
Idzer Document =

Y | Werilog Module
iargul_ghluezz:?ture IF:'xmenpu:uruI"-KiIin:-:El'I hhest_project _I
WHOL Librany

| P]WHDL Package

U] WHOL Test Bench

File name:

Location:

v &dd to project

e [nfo | ¢ Back Mext Cancel

Figure 4-23
Applying input constraints.
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26. The above process will create an ucf file and automatically add it to the project. By selecting
the ucf file in sources for window, “Run” “Assign Package Pins” process from Processes for window.
The details of the pin locations are for switches and LEDs available on TLL5000 board.

EXilinx - 1SE - F:AimenporulKilink31 stest__projectitest _project.ise - [buffer
E File Edit Wiew Project Source Process wWindow Help

ICFEE L8 EBX|wea H[20XxE
6 & ¢ [ BEEAR D[ r | = =2,
x|

15 —— Rewvi=sion

Sources for: | SynthesisArmplementation ;I i —- Revision

: - 17 —— hddirtiomn:
'-LE'-_'] teszt_project 18 ——

- £7 #c3s1500-4fgE 76 19

Bl gl buffer_8 - Behavioral (buffer_8.vhd) 20 library IEE]

E buffer_8 ucf [buffer_8. ucf] zZ1 use IEEE.STI]

ZZ2 use IEEE.3TI
Z3 use IEEE.3TI

=4
5 ———— Uncolrto:
=6 ———— anvy Xi.
=7 ——lihrary U
ES Sources e Snapzhots I |E Librarie=s I zs ——u=ze UNISII
=9
g 30 entity buffe
Procezzes for: buffer_8. ucf 31 Part [ :
: - 32 1
[  AddExisting Source 23 end buffer i
[ Create Mew Source 34 -
=3  User Constraints 35 architecturs
Eﬁ Create Timing Constraints 35

= =

= HE r Package Fins
Create Area Constraints

i

@ E dit Constraints [Text) Rerun
g{: Rerun all o
4' I E{t Stop |
EI_I: Processes I Cpen Without Updating @
= '_E,rt Properties:.. —
il
Figure 4-24

Assigning package pins.
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27.0nce “Assign Package Pins” process is run another built-in tool from ISE will be opened called
Pin-out Area Constraint Editor (PACE). Enter the pin numbers in the LOC field as shown in the
figure. The pin number details in the figure below (bottom-left window labeled “Design Object List
— 1/0 Pins”) are as needed for the TLL5000 LEDs and Switches.

H Xilinx PACE - F:A\menporul\Xilink91\test_project\buffer_8.ucf
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Figure 4-25

Applying pin numbers.

28. After entering the pin numbers in the LOC field save the file and exit the PACE tool. Then in the
“Sources for” window in ISE select the VHD file and run the “Generating Programming File”
process. This process will generate the bit file which can be downloaded onto the FPGA.
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This process will run all the other processes that are there, before the generation of the
programming file. An individual process may also be run separately.

E}Cilinx - ISE - F:imenporul'iXilink91 \test_projectitest_pro
4] File Edit Wiew Project Source Process Window H
IDFEHE Gl EBX @™ [))8
1B & E | LA D]
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""5'_'] test_project 15
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o [Peg] buffer_8.uef [buffer_S.uc) 21
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26
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=29
1] 30
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Figure 4-26
Generating bit file.
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Programming TLL5000

29. After completing “Generating Programming File” process, expand “Generating Programming
File” process tab in the “Process for” window and run “Configure Device iIMPACT” process. When
this process is executed the target board has to be connected, with the appropriate cable
connections.

=l 30 .
Proceszes for; buffer_8 - Behavioral ;I 31
; 32
-3 Design Utiities 23 e
‘% |Izer Canstraints 34
-- P Sunthesize - K5T 35 =
-- 2D mplement Design 36
= B 2 Generate Programming File 37k
OF‘rngramming File Generation Repart gg L
4]

Ef Processes I Rerun —
3igr

gt Rerun All EE0

Bl started : "Le S stop '

Srarted : "Lal Open Without Updating | .

Ef Properties...

Figure 4-27
Configuring the target platform.

30.0nce the “Configure Device iIMPACT” process is run, the below shown below appears. In this
window, just click on “Finish”.

E IMPALCT - Welcome to iIMPACT == E

—Please zelect an action from the list belor

&+ Configure devices using Boundary-S can [ TAG)

I Automnatically connect to a cable and identify Boundary-Scan chain LI
™ Prepare a PROM File
" Prepare a System ACE File
£~ Prepare a Boundany-Scan File
SWF >

= Configure devices

using Slave Serial mode =

< Back Cancel

Figure 4-28
Welcome screen of iMPACT.
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31.0Once the “Finish” is clicked the iMPACT tool will detect the boundary scan devices on the target
TLL5000. Here “xcf32p” is a flash prom & “xc9572” is a CPLD. These devices will NOT!! be
programmed. Click “Bypass” on the following window.

5 Xilinx - ISE - F-\menpomul\Xilinud1\test_project\test_project.
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Figure 4-29
Detecting boundary scan devices.
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32. This window is to select the programming file for the CPLD. Since we are not going to program

that this can also be bypassed.

EXilinx - ISE - F:\menporul\Xilinxd1\test_projectitest_project.ise - [Boundary 5can]
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| Configuration | Platform Cable USE | 6 MHz | us

Figure 4-30
Selecting programming file.
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33. The third window is for the FPGA. Please ensure that the FPGA is selected by being highlighted.

Then select the appropriate bit file and click on “Open”.
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Figure 4-31
Selecting bit file.

61

Copyright © 2007 The Learning Labs, Inc



TLL5000 Electronic System Design Base Module Getting Started Manual, v3.2

34.Now it can be observed that the FPGA is selected with the given bit file.

EXilinx - I5E - F:\menporul':Xilinx91\test_projectitest_project.ise - [Boundary Scan]
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Figure 4-32
Programming selection.

7. Right click on the FPGA that is “xc3s1500” and select program from the pop-up menu. Then the
below shown window appears. Click on “OK” in this window. This will download the bit file onto the

target device.

E Programming Properties B
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I | Data Pratest. 7| Diata Lockdown
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Figure 4-33
Viewing programming properties.
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35.0nce programming is successfully completed, the “Program Succeeded” message appears as
shown in the given figure.

@A AN D [Z2 =2 a v % " % 82 %
x|

s oo I ﬂ
yS5can
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: e B |
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‘le Formatter - file 7 - - file 7 - buffer_g bit
T
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=

iong are: |

Program Succeeded

Figure 4-34
Programming status.

Functional Test on the TLL5000

36. The design downloaded onto the TLL5000 is tested for correct functionality with the use of
switches and LEDs available on the target TLL5000.

TLwan 3
PODSRO0Z &
SIN: A

2

Figure 4-35
Observing outputs.

As the switches are toggled to ON/OFF positions, if the design is functioning correctly then the
corresponding output LEDs will turn ON/OFF to match the switch positions.

*END>*
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